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About this document

Scope and purpose

This user guide provides an overview of the reference board REF-SHA35WRC2SYS including its main features,
key test results and mechanical dimensions.

The REF-SHA35WRC2SYS is a full-featured starter kit, with a turnkey motor driver designed for high-performance,
high-efficiency permanent magnet synchronous motor (PMSM) / brushless direct current motor (BLDC)
applications, including all of the required elements for ceiling fan applications. It includes the iMOTION™
IMD112T smart driver for PFC and motor control, the IRS44273L PFC gate driver, and IKAOBN65H5 DuoPack IGBTs
and diodes for PFC, the TRENCHSTOP™ RC-Series IKNO3N60RC2 that provides cost-effective, monolithically
integrated IGBTs with diode for the inverter stage.

The starter kit features Infineon’s iIMOTION™smart driver and advanced motion control engine (MCE 2.0)
technology for PMSM/BLDC motor and PFC driver. It is optimized for small and major home appliances like
fans, pumps, compressors and other general-purpose variable speed drives.

Note: Please note that this product is not qualified according to the AEC Q100 or AEC Q101 documents
from the Automotive Electronics Council.

Intended audience

This user guide is intended for all technical specialists who are familiar with ceiling fan control and electronics
converters. The reference design is intended to be used under laboratory conditions only by trained specialists.

Reference board/kit

Product(s) embedded on a PCB, with a focus on specific applications and defined use cases that may include
software. PCB and auxiliary circuits are optimized for the requirements of the target application.

Note: The boards do not necessarily meet the safety or quality standards requirements such as UL, CE.
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Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems.

Table1 Safety precautions

Warning: The DC link potential of this board is up to 1000 VDC. When measuring
voltage waveforms by oscilloscope, high voltage differential probes must be used.
Failure to do so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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1 The board at a glance

The REF-SHA35WRC2SYS is a part of Infineon’s TRENCHSTOP™ IGBT, gate driver and iMOTION™ smart driver
reference design kits. It is designed to provide a ready-to-use ceiling fan solution based on the above-
mentioned technology as well as on the advanced motion control engine (MCE 2.0).

The REF-SHA35WRC2SYS is an optimized design for 35 W ceiling fan applications. It allows fast prototyping and
a fast time to market. It is available through regular Infineon distribution partners as well as on Infineon's
website. The main features of this board are described in Chapter 1.3 of this document. The remaining sections
provide information for customers, enabling them to copy and modify the design for production according to
their specific requirements.

Environmental conditions have been considered in the design of the REF-SHA35WRC2SYS. The design was
tested as described in this document, but not qualified in terms of safety requirements or manufacturing and
operation over the whole operating temperature range or lifetime. The boards provided by Infineon are subject
to functional testing only.

The boards are not subject to the same procedures as regular products in terms of returned material analysis
(RMA), process change notification (PCN) and product discontinuation (PD).
1.1 Delivery content

The scope of delivery contains the main board REF-SHA35WRC2SYS and daughter board XMC1100_IR_RC as
shown in Figure 2 to Figure 5, one connecting cable, and remote infrared control box. The detailed ordering
information is indicated in Table 2.

Table 2 Delivery content
Base part number Package Standard pack Orderable part number
Form Quantity
REF_SHA35WRC2SYS Boxed 1
XMC1100_IR_RC Boxed 1
REFSHA35WRC2SYSTOBO1
Cable Boxed 1
Remote infrared control box Boxed 1
User guide 6 of 57 V1.0
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1.2 Block diagram

The block diagram of the REF-SHA35WRC2SYS is depicted in Figure 1.

(infineon

Mains
120...300 V~
— AC/DC
Auxiliary power 14V -]
supply ]
Gate driver
5V 3 Phase
« inverter
Duty
IMD112T
Figure 1 Block diagram of the REF-SHA35WRC2SYS

Figure 2 to Figure 5 depict the functional groups of the main board REF-SHA35WRC2SYS and daughter board

XMC1100_IR_RC.

1. AC power input connector L, N and PE
2. Surge, EMI and soft start circuit

3. PFCinductor and IGBT IKAOSN65H5

4. Auxiliary power supply

5.iMOTION™ link connector (J1)

6. Infrared daughter board connector (J2)
7. Ceiling fan motor connector (J3)

8. DC bus capacitor

SRRV 1

o .

Figure 2 Functional groups on top side of the main board REF-SHA35WRC2SYS
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1. IGBT IKNO3N60ORC2 or IKD0O4N60RC2
2.iIMOTION™ smart driver IMD112T-6F040
3. Auxiliary power supply

4. Rectifier

Figure 3 Functional groups on bottom side of the main board REF-SHA35WRC2SYS

1. Infrared signal receiver

Figure 4 Functional groups on top side of the daughter board XMC1100_IR_RC

1. XMC1100-Q024F0064
2. XMC1100-Q024F0064 programming connector (J2)
3. Main board REF-SHA35WRC2SYS connector (J1)

Figure 5 Functional groups on bottom side of the daughter board XMC1100_IR_RC
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1.3 Main features

The REF-SHA35WRC2SYS board is an optimized reference design for 230 Vs ceiling fan applications. It contains
iMOTION™ smart driver IMD112T for controller and inverter driver, TRENCHSTOP™ RC-Series cost-effective,
monolithically integrated IGBT with diode IKNO3N60RC2 for inverter switches, 650 V DuoPack IGBT and diode
IKAOBN65HS5 for PFC switch, and IRS44273L for PFC gate driver.

Major REF- SHA35WRC2SYS characteristics include:

+ Inputvoltage range 120~300 Vims, Normal input voltage 230 Vims.

Maximum input power 35 W at T,;=25°C with input voltage range of 120~300 Vms

+ PFCfactor=0.9 at normal input voltage 230 Vims and maximum input power 35 W
+ iTHD =10% at normal input voltage 230 Vims and maximum input power 35 W

+ Surge is compliant with IEC standards IEC61000-4-5, L-N, L-PE and N-PE 4 kV

« EMIis compliant with EN55032 Class B

+ 650V DuoPack IGBT and diode for PFC switch

+ Single-channel, low-side IGBT gate driver IC for PFC switch driver

« On-board 0.3 A, 10 mH PFC inductor for 60 kHz PFC operation

+ The cost-effective, monolithically integrated 600 V Reverse Conducting Driver 2 for 16 kHz PWM motor
control

« iIMOTION™smart driver for main control and inverter driver

+ Infrared remote interface for ceiling fan speed control

« Overcurrent protection

« Auxiliary power supply with 14V

« 5Vissupplied by on-board iMOTION™ smart driver

+ Main board PCB is 90 mm diameter cycle, single layer, 1 oz. copper
+ Daughter board is 15 mm x 9 mm, 2 layers, 1 oz. copper

+ RoHS compliant
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1.4 Board parameters and technical data

Table 3 depicts the key specifications of the reference design of REF-SHA35WRC2SYS.

Table 3 REF-SHA35WRC2SYS board specifications
Parameter Symbol | Conditions Value Unit
Input voltage Vac Optimized design for 230 Vims applications 120~300 | Vims
Maximum input current | lacmax Input 120 Vims, input power = 35W, T,=25°C, 290 MAms

Motor fpwu= 16 kHZ, PFC fowun=60 kHz
natural cooling mode

Normalinput current lactorm) | Input 230 Vims, input power = 35W, T,=25°C, 155 MAms
Motor fpwu= 16 kHZ, PFC fown=60 kHz
natural cooling mode

Maximum input power | Pinmay | Input 120 ~ 300Vms, input power = 35W, T,=25°C, 35 W
natural cooling mode

Maximum motor Imtrmaxy | INput 230 Vs, input power = 35W, T,=25°C, 130 MAms
current Motor feww= 16 kHz, PFC fpun=60 kHz,
Natural cooling mode
DC bus voltage
Maximum DC bus Vaemaxyy | DC bus capacitors are 450V, 22 puF 450 v
voltage
Minimum DC bus Vacminy | Aux power supply brown-in voltage 25 v
voltage
Current feedback
PFC shunt resistance RS1 Direct AD sample, two 0.25 W, 2Q) shunt resistor 1 Q
paralleled
Motor shunt resistance | RS2 Direct AD sample, two 0.25 W, 2Q) shunt resistor 1 Q
paralleled
Protections
PFC current protection | PFCly, | IMD112T’s internal comparator for cycle-by-cycle 8531 MApeak
trigger level OCP, trip level can be adjusted by R15 & R16
Motor current Mtrlyip | Wizard setup for OC trigger level, related to AD 5002 MApeak
protection trigger level range, shunt resistor RS3, RS4 and pull-up bias
Auxiliary power supplyl - 14V
Output voltage Vavour | Used for IPM driver 14+2% |V
Maximum output lauouts 175 mA

current

1 ForiMOTION™IC IMD112T PFC overcurrent protection, there are two options in the MCEWizard setup.
If you select “Cycle-By-Cycle” mode, the PWM output immediately goes to logic LOW when the inductor current exceeds the pre-
determined OCP threshold, and re-starts at the following PWM cycle.
If you select “Latch-off” mode, PFC state machine would shift from RUN state to FAULT state when the inductor current exceeds the
pre-determined OCP threshold for a duration specified by parameter “PFC_GateKillTime”, only Fault_clear command can make it
back to STOP/RUN mode.

2 ForiMOTION™IC IMD112T, there is only one type of Gatekill input source in MCEWizard setup: comparator. The feedback current will
be compared by the internal comparator with the “Overcurrent Trip Level for Internal GateKill Comparator” value set in MCEWizard.
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Parameter l Symbol‘ Conditions ‘ Value ‘ Unit

Auxiliary power supply2 - 5V

Output voltage Vavourz | Supplied by IMD112T and power daughter board 5+4% v
Maximum output lavout2 10 mA
current

PCB characteristics

Main board dimension Diameterx height, single layer 90x65 mm
Material FR4, 1.6 mm thickness, 1 oz. PCB
Daughter board Length x width x height, double layer 19x15 mm
dimension x11
Material FR4, 1.6 mm thickness, 1 oz. PCB
System environment
Ambient temperature ‘ Ta ‘ Non-condensing, maximum RH of 95% 0~50 °C
User guide 11 of 57 V1.0
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2 System and functional description
2.1 Commissioning

This section describes how to get the system working after the user has installed the board. The following items
detail these steps. For those who are familiar with the system, or who have already run the board, some of the
steps can be skipped, depending on the user’s situation. For more in-depth start-up requirements, please refer
to the MCE reference manual or the corresponding reference material“/,

2.1.1 Hardware connection
Figure 6 shows the hardware connection details for the reference design board.

The iIMOTION™ link cable is needed to bridge the PC/debugger side and motor drive system (the target
iMOTION™ device, hot side) with 1 kV DC galvanic isolation. Users can go to Section 5.3 for more information on
the iIMOTION™ link.

1. ConnectiMOTION™ link’s 8-pin cable to main board J1 using the default pin order (only pin 5~8 are used),
and connect PC and iMOTION™link with the USB wire.

2. Then connect AC power supply (L, N, PE) and the motor (J3).
3. Connect main board J2 to daughter board J1 by cable attached in package box.

l

____ (lnfineon
13
- :

IMOTION™ Link
Isolated Debug Probe

Figure 6 Hardware connection details

Note: The iMOTION™ link shown in Figure 6 is required for tuning the board firmware, but it is not
included in the delivery content. It can be ordered separately according to the details in Section
5.3.
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2.1.2 Software tools preparation

The iIMOTION™ software tools, MCEDesigner and MCEWizard, are required to set up the system, as well as to
control and fine-tune the system performance to match users' needs. These tools are available for download
via the Infineon website (http://www.infineon.com/imotion-software). Please check this page periodically for
tool/software updates. Regarding the use of MCEDesigner and MCEWizard, please refer to the “MCEDesigner
Application Guide” and the “MCEWizard User Guide.”

Note: This reference board has been tested by the software tools MCEdesigner v2.3.1 and MCEWizard
v2.3.1. The same performance is not guaranteed for updated software tools and MCE firmware.

2.1.3 Firmware, parameter and script files preparation

If you are not familiar with the software design of iMOTION™, you can log-in to myInfineon and download the
default software package for this reference board. The package includes MCEWizard file (*.mc2’), MCEDesiger
file (“.irc’), parameter file (‘.txt’), map file (‘.map’), MCE firmware file (‘.ldf’) and script file (‘.ldf’) for this board. In
the MCEWizard file (.mc2’), all the parameters related to the board hardware and script code have been
configured as well. To make things easier and save time, you need to modify the parameters related to your
motor, and generate the parameters as described in the steps below.

Note: There are two files for all MCEWizard file (.“mc2’), MCEDesiger file (“.irc’) and parameter file (“.txt’),
the one is for remote infrared control with enabled script function, and the other one is for initial
open-loop diagnostic and closed-loop tuning without script function.

1. Use MCEWizard to open the MCEWizard file (‘.mc2’) as shown in Figure 7, then enter the target motor’s
system parameters in “Advanced Mode > Motor 1” as shown in Figure 8, which will be used to calculate the
controller’s digital parameter set, representing the complete motor drive system.

2. After the target motor’s system parameters are set, go to the “Verify & Save Page” and click on the
“Calculate Parameters and Compile Script Code” key to enable the script function; click on “Calculate
Parameters” key to disable script function. If no errors are reported, then save the drive parameters set in
your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 9. If errors are detected,
double-click on the error message (highlighted in RED) and adjust the related parameters. The saved drive
system parameter file will later be used for programmers.

3. To perfect motor running performance, the motor control parameters listed below may need to be modified
to your tuning process.

- Open loop speed ramp rate

- Parking time

- Low speed threshold

- Low speed current limit

- Current regulator bandwidth

- Speed regulator proportional gain
- Speed regulator integral gain
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File JumptoPage Help

| welcome Page

iMOTION™ 2.0 System Configuration Wizard

Ceilling Fan A test
Fan A (with IR duty ctrl)
V1.1 PCB 10hm X6

16KHz (1:3) + 60KHz PFC

Previous Next
Figure7 Wizard welcome page
File JumptoPage Help
Advanced Mode -
System  Motor1  PFC

Mator 1 Motor Parameters 2

1 - Motor Model Name

2 - Motor Rated Amps Arms

3 - Motor Poles

4 - Motor Stator Resistance Ohms/phase

5 - Motor Lq Inductance ljl mH

6 - Motor Ld Inductance mH

7 - Motor Back EMF Constant (Ke) V(In-rms)/krpm

8 - Motor Max RPM RPM

9 - Minimum Running Speed RPM

10 - Speed Ramp Rate RPM/sec

Motor 1 Startup Setting

11 - Open Loop Speed Ramp Rate (0 = Disable Open Loop Start-up) RPM/sec

12 - Parking Time (0= Disable Parking) sec

13 - Low Speed Threshold RPM v
Figure 8 Motor parameters input
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File JumptoPage Help

Verify & Save Page -

Verify Parameters

|Calculate Parameters and Compile Script Eode| |Di5play Parameters Resulls‘ |Export to MCEDesigner File (.bd)‘

Double-Click an item to JUMP to its associated question

Figure 9 MCEWizard verify and save page (script-enabled)

If you are familiar with the software design of iMOTION™, you can download MCE firmware via the Infineon
website (http://www.infineon.com/imotion-software). Select the firmware package “IMD112T-F040 MCE
Software Package v x.x.x.” Please check this page periodically for MCE firmware updates. Included in the
package are the firmware (‘.ldf’), default parameters (‘.txt’), default map file (‘.map’), the file for the
MCEDesigner(‘.irc’) and other documents. You need to modify the parameters related to your motor, but also to
configure the hardware parameters according to this reference board.

Note: This reference board has been tested by MCE firmware IMD112T-F040 MCE Software Package
v1.3.3. The same performance is not guaranteed for updated software tools and MCE firmware.

1. Use MCEWizard to enter the target motor’s system and operating parameters, as well as the reference
board’s hardware parameters. Please disable the script function and check each item carefully. Here is the
default list of the key configuring parameters for this reference board.

- Motor’s system parameters as shown in Figure 8, need to be modified for your specific motor system.
- Motor PWM frequency : 16 KHz

- PFC PWM frequency : 60 KHz

- Motor current shunt configuration: single shunt
- Application control interface: UART

- Motor control mode: speed control

- Rotor angle calculation: flux PLL angle

- Control supply voltage: 5.0V

- Maximum DC bus over-voltage: 500V

- DC bus over-voltage level: 440V

- DC bus under-voltage level: 80 V

- DC bus critical over voltage level: 499 V

- DC bus sensing high resistor: 1000 kOhms

- DC bus sensing low resistor: 10 kOhms
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- Open loop speed ramp rate: 20 RPM/sec

- Parking time: 0.5 sec

- Low speed threshold: 90 RPM, need to be modified as your actual motor system
- Low speed current limit: 40%, need to be modified as your actual motor system
- Current regulation bandwidth: 1600 rad/sec, need to be modified as your actual motor system
- Speed regulator proportional gain: 2, need to to be modified as your actual motor system
- Speed regulator integral gain: 0.8 rad/s, need to to be modified as your actual motor system
- Inverter dead time: 0.6s

- Motor current input scaling: 909 mV/A

- Internal current feedback amplifier Gain: 6

- Motor current input to ADC offset voltage: 224 mV

- Gate driver propagation delay: 0.1 psec

- Type of single shunt current sensing: phsShift

- Enable low noise phase-shift current sensing: disable

- Phase shift window size: 3 psec

- Overcurrent trip level for internal gateKill comparator: 0.5 A

- Gatekill filter time constant: 0.5

- Cacth spin before start: enable

- Catch spin time: 0.1 psec

- Target DC bus voltage initialization: 360 V

- PFC topology: boost

- PFCinductance: 7 mH

- PFC current measeurement input scaling: 806 mV/A

- PFCinternal current feedback amplifier gain: 6

- PFC current sensing input polarity: inverting

- AC input frequency: 50 Hz, need modify as your actual input power

- AC voltage sensing high resistor: 1000 KOhms

- AC voltage sensing low resistor: 10 KOhms

- PFC low side gate driver polarity: high

- PFC current sample delay time: -0.2 psec

- PFC voltage reference ramp rate: 50 v/sec

- PFC duty-feed-forward factor: 0.83

- PFC voltage regulator proportional gain: 1500

- PFC voltage regulator integral gain: 30

- PFC current regulator proportional gain: 400

- PFC current regulator integral gain: 600

- PFC over-current-protection: cycle-by-cycle

- Enable Vdc under voltage fault: enable

- Enable Vdc over voltage fault: enable

- Minimum AC input voltage fault: 100 Vrms

- Enable Vac under voltage fault: enable

- Maximum AC input voltage: 310 Vrms

- Enable Vac over voltage fault: enable

- Enable AC input frequency protection: disable
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2. After system and operating parameters are set, go to the “Verify & Save Page” and click on the “Calculate
Parameters” key to disable script function. If no errors are reported, then save the drive parameter set in
your project directory by clicking “Export to Designer file (.txt)” as shown in Figure 10. If errors are detected,
double-click on the error message (highlighted in RED) and adjust the related parameters. The saved drive
system parameter file will later be used for open-loop diagnostic and closed-loop tuning.

Verify & Save Page -

Verify Parameters

Calculate Parameters. Display Parameters Results Export to MCEDesigner File (.tx)

Double-Click an item to JUMP to its associated question

Information #1 : Firmware Version

Firmwrare Version is v1.03.5e¢ [For(.x), means any min version between .0 to .9]
Information #2 : System DC Bus Feedback Scaling

The DC Bus Feedback Scaling is 8.11 counts/Volt and max measurable voltage is 505.00V
Information #3 : Motor 1 Current Feedback Scaling

The Motor Current Feedback Scaling is 4467.92 counts/Apk and range is -0.25 to +0.67 Apk
Information #4 : System Configuration Options

->MCE Device OverCurrent Level: 0.5 Apk

->Current Feedback: Single Shunt

->Motor Current Sensing Range -0.25 to +0.67 Apk

->Angle Feedback: Flux PLL Angle

->Control Mode: Speed Control

->Control Input: UART
Information #5 : PFC Vac Scaling

The PFC Vac feedback scaling is 4.05 counts/Vpk and max measurable voltage is 505.00 Vpk
Information #6 : PFC Configuration Options

->Topology: Boost

->Voltage Mode: Fixed-Voltage

Previous Next

Figure 10 MCEWizard verify and save page (script-disabled)

3. Ifthe open-loop diagnostic and closed-loop are tuned up, enable the script function in the “Options Page”
of MCEWizard, and copy the default script code for remote infrared control in the Code Listing 1 to “Script
Edit Page >Script Coding tap” in the MCEWizard as shown in OFigure 11. Then generate the execution file of
script code for remote infrared control tuning by clicking “Script Code Complier” in “Script Edit Page >Script
Coding tap” or go to the “Verify & Save Page” and click on “Calculate Parameters.” For more information
regarding script, please refer to the MCE reference manual®.

Script Edit Page -

Script Configuration  Script Coding

Script File Operation

Copy Script Code from a File... Save Script Code as a File... Script Code Compiler...

Script Text Edit

1 #5ET SCRIPT_USER_VERSION (1.00) /*Script version value should be 255.255%/ K

2 #SET SCRIFT_TASKO_EXECUTION_PERIOD (5) /*Script execution time for Task0 in mS, maximum value 65535%/

3 #SET SCRIFT_TASK1_EXECUTION_PERIOD (1) /*Script execution time for Taskl in 10mS, maximum value
65535%/

4 #SET SCRIPT_START_COMMAND (0x3) /* Start command, TaskO : Bit0, Taskl : Bitl; if bit is set, script executes
after init #/

5 #SET SCRIFT_TASKO_EXECUTION_STEP (10) /= Script Task0 step, This defines number of lines to be executed
every 1ms*/

6 #SET SCRIFT_TASK1_EXECUTION_STEP (30) /* Script Taskl step, This defines number of lines to be executed
every 10ms™/

7

S sk
9

10 int sVar_MotorStatus;//0 for stop, 1 for normal run, 2 for break

11 int sVar_RdDuty;

12 int sVar_RcCmdSpd;

13
14 int sVar_AbsFanSpd; v
Previous Next

Figure 11 Script edit page
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Code Listing 1

Default script code for remote infrared control

001 #SET SCRIPT USER VERSION (1.00) /*Script version value should be 255.255*/
002 #SET SCRIPT TASKO EXECUTION PERIOD (5) /*Script execution time for Task0
in mS, maximum value 65535*/
003 #SET SCRIPT TASK1l EXECUTION PERIOD (1) /*Script execution time for Taskl
in 10mS, maximum value 65535%*/
004 #SET SCRIPT START COMMAND (0x3) /* Start command, TaskO Bit0, Taskl Bitl;
if bit is set, script executes after init */
005 #SET SCRIPT TASKO EXECUTION STEP (10) /* Script TaskO0 step, This defines
number of lines to be executed every 1mS*/
006 #SET SCRIPT TASK1l EXECUTION STEP (30) /* Script Taskl step, This defines
number of lines to be executed every 10mS*/
007
008 /*****************************************************************************
***********************/
009
010 int sVar MotorStatus;
011 int sVar RdDuty;
012 1int sVar RcCmdSpd;
013
014 int sVar AbsFanSpd;
015 int sVar ErrorCode;
016 int sVar VacRMS Flt;
017 int sVar FollowPFCCmd;
018
019 int sVar tempO;
020 int sVar templ;
021
022 /*
023 Read Dutycycle about 10% ~ 90% (total 664us)
024 Ton is 66us,199%us, 332us, 465us, 598us
025 */
026
027 /*Task0 init function*/
028 Script Task0 init()
029 {
030 sVar MotorStatus = 0;
031 }
032
033 Script Taskl init()
034 {
035 sVar MotorStatus = 0;
036 P11Kp = 600;
037 P11Ki = 100;
038 vd Ext=0;
039 Vg _Ext=0;
040 AngleSelect =2;
041 CtrlModeSelect =2;
042 Command = 0;
043 PFC Command = O;
044
045 TargetSpeed= 1600; //initial motor speed 40 rpm
046 PFC_TargetVolt = 2400; //initial PFC target voltage 296V
047 }
048
049 /*****************Tasko Script function*******************/
050 /*******x*x*+*x*RC commnad read and deal 5ms run**kkxkxkkok/
051 Script TaskO()
052 {
053 int ControlDutyTemp;
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Code Listing 1 Default script code for remote infrared control

infineon

055 // Input low level active

085 /************Taskl Script function***************/
086 /******************loms run*********************/

087 Script Taskl()

054 // Read ControlDuty: 100~900cts for 10%~90% dutycycle,update every 10 ms

056 ControlDutyTemp = 1000 - ControlDuty;

057 if (ControlDutyTemp < 0)

058 {

059 ControlDutyTemp = 0;

060 }

061 if (ControlDutyTemp > 1000)

062 {

063 ControlDutyTemp = 1000;

064 }

065 sVar RdDuty = (ControlDutyTemp + 7 * sVar RdDuty + 4)>>3; //LPF for 1/8
066

067 //Stop or Wrong input, keep Stop and fix SpdCmd = 0

068 if ((sVar RdDuty > 950) || (sVar RdDuty < 50))

069 {

070 sVar RcCmdSpd = 0;

071 Command = 0;

072 PFC_ Command = O;

073 }

074 else

075 {

076 sVar RcCmdSpd = sVar RdDuty * 16; //Transfer Dutycycle to speed count
077 //(10% --> 1600cts)

078 if (sVar RcCmdSpd > 14386)

079 {

080 sVar RcCmdSpd = 14386; //1limit motor speed to max speed 360 rpm
081 }

082 }

083 }

084

088 {

089 /******Read and LPF*******/

090 //Read MCE fault

091 sVar ErrorCode = SwFaults;

092

093 // LPF for Vac RMS

094 sVar VacRMS Flt = (7*sVar VacRMS Flt + PFC VacRMS + 4)>>3;
095

096 //1.414*32= 45.248 // Vacpeak +10V

097 sVar FollowPFCCmd = 81 + (sVar VacRMS Flt * 45 + 8)>>4;

098

099 // LPF for Fan ABS speed feedback

100 sVar AbsFanSpd = (7*sVar AbsFanSpd + abs MotorSpeed + 4)>>3;
101

102 /******Motor and PFC control, (0,1,2 state machine) *****xxx*xx%/
103 // Stop PWM if CMD is too low or MCE fault

104 if (( sVar RcCmdSpd < 1000) || (sVar_ ErrorCode >0))

105 {

106 Command=0;

107 PFC Command = O;

108 sVar MotorStatus = 0;

109 }

110 else // Start Motor and update Spd & TargetVolt

111 {

112 if (sVar MotorStatus ==0) //From STOP to Start
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113 {

114 sVar MotorStatus = 1; //Motor start

115 AngleSelect =2;

116 CtrlModeSelect =2;

117 TargetSpeed = sVar RcCmdSpd; //Normal Run Speed
118 Command = 1; //Start motor PWM
119 }

120

121 //Start PFC when motor start OK (speed over Minspd)

122 if ((sVar MotorStatus ==1) && (sVar AbsFanSpd > 1200))

123 {

124 sVar MotorStatus = 2; //Motor started

125

126 //PFC start with a very low voltage REF to reduce power loss
127 PFC TargetVolt = 2400;

128

129 //Start PFC PWM

130 PFC_ Command=1;

131 }

132

133 //Normal PFC and motor run, update PFC and motor speed command
134 if (sVar MotorStatus ==2)

135 {

136 TargetSpeed = sVar RcCmdSpd;

137

138 //360RPM= 14386-->2877-->354V, 16383/5 = 3276 -->404V DCBUS
139 sVar temp0 = sVar AbsFanSpd/5;

140

141 if (sVar temp0 > sVar FollowPFCCmd)

142 {

143 //High spd & BEMF, need higher Vdcbus to support motor run
144 PFC TargetVolt = sVar tempO;

145 }

146 else //lower Vdcbus as possible to reduce power loss

147 {

148 //Low Spd or high Vac input, Vdc tracking Vac peak +10V
149 PFC TargetVolt = sVar FollowPFCCmd;

150 }

151

152 if (PFC TargetVolt > 3244) //MAX Vdc limit: 400V *8.11 = 3244 cts
153 {

154 PFC TargetVolt = 3244;

155 }

156 }

157 }

158 }

159 /***x*xx*xEnd of Script*x*x*xxx/
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Script_TaskO_init()

Initialize motor running status

Task0 loop

\

r

Script_Task0()

1. Get

duty signal;

2. Output motor target speed

value.

<

q

Script_Task1_init() )

Control variables initialization ‘

Y

A

Start

(Duty < 50)&&(Duty > 950)7

N \d
Target speed
value =Duty * 16
Y
. Y
Stop PFC; Targetspeed
Stop motor; value = 14386
Target speed value =0.

A

End

G

_ | 1.Read MCE fault Swfaults;
2.Read PFC_VacRMS, calculate aVar_FollowPFCCmd and filter;

3.Read motor speed abs_MotorSpeed and filter;

Target speed value < 1000) || (MCE fault = True )?

i« Script_Task1() Start motor;
sVar_MotorStatus = 1;

| -
o
_8 1. Get MCE fault and motor speed;
g |2 Motor and PFC start logic; —TsVar_MotorStatus = 1)&&(Motor speed > 12007 —= v
E 3. Adjust motor target speed and PFC Stop PFC;

target DC bus value online. Y Stop motor;
A Start PEC;
B PFC_TargetVolt =2400;
sVar_MotorStatus = 2;
-
T oo I
Y
Adjust motor target speed online
Adjust PFC target DC bus value online

Y

End )
Figure 12 Flow chart of default script code
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Figure 12 shows the flow chart of default Script code. There are two tasks: Script_Task0 and Script_Task1.
Script_Task0 executes every 5 ms and Script_Task1 executes every 10 ms. Script_Task0 is to get duty signal
from the daughter board and output motor target speed value. Script_Task1 is to get the MCE fault and motor
real speed, control motor and PFC start logic and adjust motor target speed and PFC target DC bus value
online.

2.1.4 Program firmware/parameters/script

The REF_SHA35WRC2SYS reference design kit is shipped with pre-programmed firmware, default parameters
and Script for remote infrared control, since the functional tests are performed before the shipment. Users
need to program their parameters, as the users’ ceiling fan motor may be different from the one under test.

Program the IMD112T-6F040 as follows:

e  Program the firmware of the MCE
e  Program parameter sets for system and motor
e  Program customer script file (optional)

or

e  Program the combined file, which is generated by MCEWizard, and contains all three items above.
Customer script file is optional depending on whether it is available. The combined file is usually used
for production, since it only needs to be programmed once.

The programming process is as follows:

1. Startthe MCEDesigner tool and open MCEDesigner file (“.irc’) for the IMD112T device prepared in Section
2.1.3 by clicking “File” > “Open.”

2. Power the iIMOTION™ control IC with 3.3 V. It is recommended to program the IC with the 3.3 Visolated
power supply that comes from the iMOTION™ link; there is a switch on the iIMOTION™ link to enable the 3.3
V output. The iMOTION™ control IC will also be powered by the on-board auxiliary power supply after the AC
source is powered. Caution must be taken in the latter case due to high voltage.

Note: The output voltage of LDO combined in the IMD112T-6F040 is 5V, i.e. the controller of IMD112T-
6F040 is powered by 5 V. However, it is also possible to use the 3.3 V power supply in the iMOTION™
link to power the IMD112T-6F040 (for programmers).

3. MCEDesigner should automatically connect to the board using the default COM port (indicated by the green
circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI) when iMOTION™ control IC is
powered. If it cannot establish the connection due to an incorrect COM port, change the COM port by doing
the following: click on the “System Page” window and then click on “Preferences > Connection > Connect
using” and choose one of the other available COM ports from the drop-down list.

4. Incase of ablank IC: If the firmware has been erased from the IMD112T-6F040, the following warning
message will pop up “Target device firmware and parameters file are not programmed! Please program
firmware and parameters file” as shown in Figure 13. Then you can program the firmware and parameters
as described in Step 5. If it is not a blank IC, no such message will be indicated.

MCEDesigner X

target device firmare and parameters files are not programmed!
! . Please program firmare and parameters files,

Figure 13 MCEDesigner warning message
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5. Use the following steps to program the firmware and the parameters file to the internal Flash memory of
iMOTION™ Control IC as follows: click on the system page, click “Tools” > “Programmer” and select
“Program Firmware and Parameters,” as shown in Figure 14 below. Regarding the firmware and parameters
file, browse and select the “.Idf’ and ‘.txt’ file prepared in Section 2.1.2.

Operation Options

(" Program Farameters @& Program Firmware and Parameters Program Script ( Program Combined File

File
Program Parameter File |Se|ed Parameter. document type(* |df) Browse...
Program Firrnware File |Se|e:tfirmwarel document type*.Idf) Browse...

Frogram Script File |

ail;

Frogram Combined File |

Start Cancel

Figure 14 Program the parameters and firmware

6. If the script file needs to be programmed in the internal Flash memory of iIMOTION™ Control IC after
programmed firmware and parameters file, still click on system page, click “Tools” > “Programmer” and
select “Program Script,” shown as in Figure 15 below. Regarding the Script file, browse and select the
‘xxx_Script.ldf file prepared in Section 2.1.2. After programming script, please click “File” > “Import Register
Map” to import script (.map) file into MCEDesigner file (.irc), and save this (.irc) file, otherwise a map error
will appear.

COperation Options

(" Program Parameters  Program Firrmware and Parameters (@ Program Script ( Program Combined File

File

Frogram Parameter File |

Frograrm Firmware File |

Program Script File |‘SEIEE:I Soript document type(* Idf Browse

ual;

Frogram Combined File |

Start | Cancel |
Figure 15 Program the script
Note: For detailed information on controller programming, refer to AN2018-33 iMOTION™ 2.0 device

programming, MCEDesigner documentation and MCEWizard documentation.

2.1.5 Open-loop diagnostic

Make sure the input power is 230 Vrms, and program only the firmware and parameters file (script function
disabled) without remote infrared script control.

Double-click the “VF Diagnostic” function in the window of motorl, and monitor motor current with
oscilloscope. If the motor current is not sinusoidal, change register TargetSpeed and Vd_Ext in the VF
Diagnostic sub-function, then double-click “VF Diagnostic” until the oscilloscope shows a steady sinusoidal
current with an amplitude of 30~50% motor rate current.
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Double-click “lu & Iv_Slow” in “System page > Monitor Definitions.” The motor current feedback should be very
clean and sinusoidal, as shown in Figure 16; otherwise please tune “Gating Driver Propagation Delay & Phase
Shift Window Size” in MCEWizard.

“VF Diagnostic” sub-function can check whether:

e The ceiling fan motor is connected correctly

e The power stage works as expected

e Current-sensing related parameters are correctly configured

e The PCB layout and DC bus decoupling have been done correctly

After “VF Diagnostic” is done, click STOP button (the red traffic light button) or run the “stop motor”
function to stop the motor.

Note: Please do not start PFC in this diagnostic process.

1000-

Goo—

=400

-1000

500

Figure 16 Trace waveform for lu & lv open loop diagnostic

2.1.6 Closed loop run

Make sure the input power is 230 Vrms, and only program firmware and parameters file (script function
disabled) without remote infrared script.control.

If the VF Diagnostic works correctly, the hardware circuit and signal sampling will work normally, at which point
you can try to run the ceiling fan motor in a closed-loop mode. Follow the steps as listed below.

1. Start the motor by clicking the green traffic light button in the control bar (or double click Start Motor sub-
function in the window of motorl, which is in the group of User Application Function Definitions). The motor
will run if above step works correctly.

2. Check the motor spin direction, adjust the connection order of the motor’s winding; the motor spin
direction must match the normal running direction of the ceiling fan.

3. Set TargetSpeed to about 50% of maximum speed, start “lu & FIx_M” trace with “Auto Repeat on Level,” see
Figure 17. FIx_M is good within the range of 2000~2500 (rated value is 2048), and must be steady and DC-
like.
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1000-

Figure 17 Trace waveform for 1., & Flx-M at 50% speed

4. If motor closed loop is tuned up, then the PFC can start when the motor is running. Starting the
“PFC_AbsVac & PFC_Iref” trace with “Auto Repeat on Level” (see Figure 18) will show the PFC performance.
The default PFC DC bus target value is set in MCEWizard “Target DC Bus Voltage Initialization.”

1] 50 100

Figure 18 PFC_AbsVac & PFC_Iref

5. Once the firmware has been programmed, and only a new parameter file has to be programmed, follow the
same instructions given in Section 2.1.4. In this case, the firmware programming is no longer needed, and
you can select the first option “Program Parameters.”

Here are some key tips for better motor-performance tuning:

e If FIx_Mis not steady (swing or oscillation), check the following: motor parameters, speed loop PI
bandwidth, current loop bandwidth, flux estimator time constant and PLL Pl bandwidth (parameters PLLKp
and PLLKi) and related equipment.

o If FIx_Mis very noisy, check the following: current feedback and V4. feedback related hardware and
parameters.

e If FIx_M does not come close to 2048, “Motor Back EMF Constant (Ke)” needs to be adjusted in MCEWizard.

e The PFC parameters in the software package downloaded from mylInfineon are optimized for the reference
board. So it is not necessary to change them.
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If the open-loop diagnostic and closed loop work correctly, then the infrared control can be tuned.

2.1.7 Infrared control

1. Connect the J2 of main board to J1 of daughter board by cables, as shown in Figure 6. The daughter board
can receive remote infrared command from the control box.

2. Program firmware, parameters file (script function enabled), and script file for remote infrared control by
iMOTION ™link. The iMOTION ™link can be removed after programming if you do not want to view the MCE
variables’ wave or value from MCEDeisgner.

3. The attached remote infrared control box is shown in Figure 6. There are only power,and 1, 2, 3,4, 5
buttons. The power button is to enable or disable controller transmitting. If the controller transmitting is
enablbed, you can select incrementally different motor speeds with button 1, 2, 3, 4, 5. Button 5 refers to
maximum motor speed. The daughter board can remember the last set speed by the control box before
power button being disabled, so the motor will start at the last-used setting speed when power button is
enabled.

2.2 Description of the main board functional blocks

2.2.1 EMI filter and surge protection

Figure 19 shows the diagram of the EMI filter and surge protection. The EMI stages consist of two X-capacitors
of 100 nF and 330 nF respectively, two series Y-capacitors of 3.3 nF and 4.7 nF respectively, and a 22 mH
common-mode inductor. The surge protection circuit consists of two stages of MOV, RV1 and RV2; their reverse
break down voltage is 470 V. The conducted electromagnetic interference of this board is shown in Section 4.7.

R3
Xl X
E L S — 1000F IMEG
J — D1 D3
3A, 250Vac B oM oM
X2 NTCI y e . Vi NN
S N 22mH ex2]
- h RV 1022 3300
4] 35Un;
R 470v
|LCYl
| e >
Levs |cva
=3.30F T[-3.30F RV2
|LCY2 470V Vi NN
X3 |2 77nF
3 EARTH D2 D4
;} IN4007G- SIM
Input: 120~300Vac

Figure 19

2.2.2

EMI filter and surge protection

DC bus sensing and MCEWizard configuration

Figure 20 shows the detail of the DC bus sensing resistor divider stage.

With the values shown in the figure, the default DC bus-sense voltage results in a range of 0 Vto 5V on the ADC

input of the microcontroller (MCU), reflecting an input voltage range from 0V to 505 V.
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Figure 20 DC bus sensing

The hardware parameters need to be configured in MCEWizard as shown in Figure 21.

File JumptoPage Help

Advanced Mode -

Motor 1 PFC

System

21 - User UART Tx Delay Time

System Options

23 - Safty Function Tests Enable/Disable

24 - Controller Supply Voltage

25 - Temperature-based CPU clock compensation
26 - Control Input measurement

31 - Parameter Set Number

Disable ~
5.0 v|V
I

System DC Bus
[ sv
[ sy
80|V
499 | Vv

1000 | KOhms
10 | KOhms

46 - Maximum DC Bus Voltage
47 - DC Bus Over-Voltage Level
48 - DC Bus Under-Voltage Level

49 - DC Bus Critical Over Voltage Level

50 - DC Bus Sensing High Resistor

51 - DC Bus Sensing Low Resistor

Previous Next

Figure 21 DC bus sensing configuration in MCEWizard

The Vdc-sensing stage features a low-pass-filter time constant that can be calculated as:

Time constant = (R22//R21) * C18 = (1 MQ//10 kQ) * 10 nF = 99 ps Eqg. 1
The value of capacitor C18 can be adjusted to improve the V4 noise rejection ratio.
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2.2.3 Inverter section

The inverter section is implemented with the latest generation of RC-D2 IGBT in a SOT223 package
IKNO3N60RC2 or in a DPAK package IKD04N60RC2. The default mounted devices are IKNO3N60RC2. 600 V RC-D2
is the successor to the RC-D/DF IGBT. The latest version of the RC-D technology has several improvements
compared to its older version: better price, lower power losses, and better controllability over the di/dt in order
to further reduce EMI compared to RC-D/DF. These devices are also robust for high-voltage and high-humidity
operations.

Features of IKNO3N60RC2 and IKDO4N60RC2:

« Very tight parameter distribution

+ Operating range of 1 to 20 kHz

« Maximum junction temperature of 175°C

« Short-circuit capability of 3 us

« Best-in-class current versus package size performance
+ Qualified according to JEDEC for target applications

« Robust design for high-humidity operation

+ Pb-free lead plating; RoHS compliant

« Complete product spectrum and PSpice Models

Figure 22 shows the diagram of the inverter and peripheral circuit.

X5

[l
DCP|-# .

IKNO3N60RC2 IKNO3N60RC2

IKNO3NGORC2

RM  ooop @ R30 o o R34 o Qs
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I3
—— — —
(I — T w 3¢
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. 691102710003
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BAV16WS-7-F BAV16WS-7-F BAV16WS-7-F
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Figure 22 The inverter and peripheral circuit
2.2.4 Motor current sensing and overcurrent protection
2.2.4.1 Motor current sensing

The motor current sensing on this board uses only a RC network for operational gain, bias and low-pass filter to
minimize the cost. No additional operational amplifier is needed.

With reference to Figure 23, you can derive the following equation by applying the principle of Kirchhoff's
voltage law, assuming that the MCU analog-to-digital converter (ADC) input port has an infinite impedance.
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(Vcc - Vshunt)
Vv =———— " %R, +V Eqg. 2
ADC R, + R, * Ry shunt q

The equation can thus be adjusted as shown:

Vi = Ry * Vspune | R1* Ve Eq. 3
ADC™ R, +R, Ri+R,

Since the impedance of the RC network is much larger than the Rgpyns, it follows that:

Vshunt = Ishunt * Rshunt Eqg. 4

As a consequence, Vapc can then be written as:

R, Ry * Ve
Vapc = R, + R, * Rspunt * Ishune T+ m Eq. 5
1 1
Where 21Vee is the offset, and the gain of the shunt current is Ra 4 Repunt-
R{+R; R1+R;
PWM(UH) PWM(VH PWM(WH)

.|_ PWM(UL) PWM(WL) b PWM(WL)'
DCBus{ _ MCE Device

Vee Inner Amplifier
*1/3/6/12 configurable
By MCEWizard
R2
R3 U /1SS | ADC
[ | o K 0-3.3V or 5V
R1 | 12bits
Rs Cl (0-5V for IMD)
Figure 23 Motor current-sensing topology
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[l REFU 39
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1k —= IV/AHALL2 N
- R1
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47R _LCI TXDO 27
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Figure 24 Motor current-sensing circuit on the board

As an example in Figure 24, this board has the following values: R1=R1=47 Q, R2 = R4 =1 kQ, Rs = RS3//RS4 =
1Q, V.. =5V. By using the formula in Eq. 5, the offset is 224 mV, and the gain is - }:ZR * Ropune =955 mV/A.
1 2

Because the amplitude attenuation of low-pass filter, the gain needs to be amended to 909 mV/A for
MCEWizard configuration.

Note the following points concerning motor current sensing:

e RlandR4inFigure 24 determine the ADC operational bias for current sensing, which corresponds to the
motor regeneration operation range. For applications that do not work with a regenerative braking mode,
the bias can be as low as possible to reserve enough ADC range for the drive mode, since the currentin the
sense resistance always flows in one direction only. In this example, the offset is 224 mV.

e Since the gain of the external RC circuit is less than 1, internal signal amplification is required to increase the
current signal acquired with low shunt resistance values. MCE provides an inner current sampling amplifier
with *1, *3, *6 and *12 gain selections, which can be configured in the MCEWizard. In this example, the inner
current sampling amplifier is *6, so the current sampling range is from 224 mV to 833 mV.

e There is no common mode noise suppression capability without an outer operational amplifier, so the GND
network of the PCB needs to be designed very carefully, since any voltage difference between IMD112T’s
ADC ground and shunt resistor ground will be considered as an “input signal,” and will deteriorate the
control performance or increase audible noise.

2.2.4.2 Motor overcurrent protection

The motor overcurrent condition can be detected by IMD112T-6F040 with internal comparator as shown in
Figure 25.
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Figure 25 Motor overcurrent protection topology
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For more details about motor overcurrent protection (OCP) in the IMD112T, please see the chapter about motor
overcurrent protection in the reference material ..

The internal comparator’s reference level is set by the internal digital-to-analog converter (DAC) so the level
can be set in the MCEWizard by “Overcurrent Trip Level for Internal Gatekill Comparator” and “Motorl current
input to ADC offset voltage.” The DAC output pin REFU needs to be connected to a capacitor to improve noise
rejection (e.g. a 100 nF/25 V capacitor is used on the board as shown in Figure 24).

2.2.5 PFC section

Figure 26 provides the PFC MOSFET driver and peripheral circuit.

NTC & RV1 limit input voltage to 470V
L4
0 MURS160-E3/5BT DCP
; ol i~ b
5 10mE 4
SIM DS
iy IKAOSN65HS
o R22
1 cio IMEG
T 330F 1 1+
clé Max Vdc: 505V @5V
22uF
cl4 vDe
i D14 15 B21 vDe
SIM|A ! c18
N 10k 10nF
D4 — P22 R
3 =
SiM ——d nkJ.'uﬁ%
u2
2 - eTel 3 ] »
RI3 —— coM vee {+14v
330R .
RO I ouT1 ; R23
< N [ }——{PFCGO
180R DIsSpN 2] oum J_ —
BAVI6WS-7-F FEwmmr L cio o
10uF LoF
RI10

20K, Max Vac peak 505V @5V Vdd

e ==
v 5V & 6X: 833mV Max

Ofst: 762mV for 6X AD gain

Figure 26 The PFC and peripheral circuit

e AnIRS44273L is used for the PFC MOS drive. C14, R13 & R14 select the PFC MOSFET switching du/dt; trade-
off between switching noise and power loss is required.
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e Thebypass diode D14 is designed to bypass the surge current during surge voltage input.
e Tworesistors (1% tolerance, 2 Q, 0.25 W) are used for PFC current sensing.
e 10mH 0.3 Ainductor is used for PFC.

e 650V DuoPack IGBT with diode IKAON65HS5 is used for the PFC switch. IKAON65H5 belongs to the high-
speed switching series of the fifth generation, and has best-in-class efficiency in hard switching and
resonant topologies.

2.2.6 PFC current sensing and overcurrent protection

2.2.6.1 PFC current sensing

The PFC current sensing on this board uses an RC network for operational gain, bias and low-pass filter to
minimize the cost. No additional operational amplifier is needed. The PFC current-sensing topology is as shown
in Figure 27. From the point view of the AD converter, the current input scaling value is the product of the
voltage of PFC shunt resistor and the gain of RC network.

mV
A

ADC port voltage for .
PFC current sample

Rahprc (Gain)mV

Vac

PFC current

Figure 27 PFC current-sensing topology

As shown in Figure 26, two resistors RS1 and RS2 (paralleled) with 1% tolerance, 2 Q, and 0.25 W are used for
the PFC shunt resistor in this reference board. The real AD input voltage can be calculated as below according
to the principle of Kirchhoff's voltage law:

IPFC_ Ro + Ry sh,pFC * IsnPFC Ro + Ry qg.

1K 18002 * 5V

VIPFC_ = m * 100 * ISh,PFC + m = 0847(mV/A) * sh,PFC + 762 mV

So the offset of PFC current sampling is 762 mV, and the gain is 847 mV/A. Because of the amplitude attenuation
of the low pass filter, the gain needs to be amended to 806 mV/A for MCEWizard configuration.

Note the following points concerning PFC current sensing:

e Since the gain of the external RC circuit is less than 1, internal signal amplification is required to increase the
current signal acquired with low shunt resistance values. MCE provides an inner current sampling amplifier
with *1, *3, *6 and *12 gain selections, which can be configured in the MCEWizard. In this example, the inner
current sampling amplifier is *6, so the maximum input PFC current-sampling voltage should range from 0
mV to 833 mV (5V/6).

e In this reference board design, the voltage level on the PFC current-sensing resistor is negative with
reference to ground, so an ADC operational bias is needed, and PFC current-sensing input polarity should
select “inverting” in MCEWizard. R9 and R10 in Figure 26 determine the ADC operational bias for current-
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sensing; the bias value is 762 mV, so the real AD sampling range for the PFC current-sampling voltage ranges
from 0 mV to 762 mV.

e There is no common mode noise suppression capability without an outer operational amplifier, so the GND
network of the PCB needs to be designed very carefully. Any voltage difference between IMD112T’s ADC
ground and shunt resistor ground will be considered as an “input signal,” and deteriorate the PFC
performance and increase harmonic distortion.

2.2.6.2 PFC overcurrent protection

The PFC current-sensing signal feedback to IMD112T-6F040 goes via two pins, the IPFC for PFC control, and the
PFCITRIP for PFC overcurrent protection. The PFC overcurrent condition can be detected by IMD112T-6F040
with internal comparator as shown in Figure 25. The overcurrent threshold is designed by the voltage value at
input pin PFCREF.

Rsh,PFC

Vac

MCE Device

PFCREF
* Digital
. PFCITRIP Fiter }_PV.W
PWM in

R2 R3 IPFC

T

Figure 28 PFC overcurrent protection topology

For more details about the PFC overcurrent protection (OCP) in the IMD112T, please refer to the relevant
chapter in the reference material .,

Note the following points concerning PFC overcurrent protection:

e The PFC overcurrent threshold of this board is designed by R15 and R16, and the threshold value is
150 0 762 mV=73.9 my

————— x5V = 73.6 mV . That means the PFC overcurrentis —————— = 854 mA.
10 KQ+150 2 806 mV/A
2
HALL1/GPIO? |23 +5V
PFC R15
10k
'~ ]
PECRER ks Cl5 _IP12
IuF [T]“f’
I :
PFCGO ka2 PECGO ——e=mn, —[ 150R
p
150R Ofst: 73.9mV for PFC Itrip

Figure 29 PFC overcurrent threshold design on the board
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e The PFC overcurrent has two available modes: latch-off and cycle-by-cycle. This reference board uses cycle-
by-cycle mode. For more details about the two PFC overcurrent protection mode, please refer to the
relevant section in the reference material .,

. .
2.2.7 Interface circuit of IMD112T
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Figure 30 Interface circuit of IMD112T

Figure 30 shows the interface circuit of IMD112T:

e The power of IMD112T is 14V and 5V power generated by internal LDO in IMD112T
e UH, UL, VH, VL, WH, WL provide driver for inverting circuit

e IFB+COM is the motor current sensing signal

e |IPFC-isthe PFC current sensing signal

e VAC1 and VAC2 are AC input voltage sensing signals for PFC

e PFCGO is the PFC driver

e PFCREF is the threshold input of PFC overcurrent protection

e VDCis the bus voltage sensing signal

e LED2istheindicator light of IMD112T power on

e IR_Duty is the duty input signal from the daughter board

e VSP function is only reserved for a wall regulator, and is not enabled in this board
¢ RX0and TX0 are debugging and programing communication channels to MCEDesigner
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2.2.8 Interface circuit to XMC daughter board

XMC daughter board

| '
I 12 0
Y 4 |
T.ﬁv ! swsess e Be l
_L . . SGND2 I

C17 ¥ *IR Dutyl
IUF l : LN N N N N ] I
I | I 112554p 0
< | \-Bwsr_ __ !

7R Dates IR Duty
Figure 31 Interface circuit to XMC daughter board

Figure 30 shows the interface circuit to the XMC daughter board. Its function is to power 5 V for the XMC
daughter board and receive the duty signal translated from the remote infrared control box.

Note: For the firmware version V1.03.03 of IMD112T, the infrared signal needs to be translated to duty
signal by the XMC1100 on the XMC daughter board. The IR_Duty signal is the translated duty signal
from the XMC daughter board.

Note: The future updated firmware version of IMD112T, will be able to translate the infrared signal, so
the IR-Duty signal can connect to the infrared receiver directly, and does not need to be translated
by XMC1100.

2.3 Description of the daughter board functional blocks

This section depicts the XMC daughter board, which receives signals from the remote infrared control box and
translates them to duty signal to control the motor speed of the ceiling fan.
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2.3.1 Circuit of daughter board
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Figure 32 Circuit of daughter board

As shown in Figure 32, the IRM-3640T receives signals from the remote infrared control box, and XMC1100
translates them to duty signals. The LED1 indicates the width of the output duty and becomes brighter as the
width narrows. LED2 and LED3 indicate that XMC1100 has received infrared signals, but their logic is contrary.
LED2 lights up (is normally off) and LED3 goes off (is normally lit up) when the XMC1100 has received infrared
signal.

The J2 is for programming XMC1100, which was programmed before leaving the factory.

Note: The future updated firmware version of IMD112T will be able to translate the infrared signal, so the
IR-Duty signal can connect to the infrared receiver directly, and does not need to be translated by
XMC1100. Only the components in the green frame need to be mounted. Remember to mount R7,
which is not needed in the present application.

2.3.2 Output duty signals versus buttons

Figure 33 depicts the output duty signals from the remote infrared control box. When the power button is
disabled, the output signal is at high level and all other buttons are inactive. When the power button is enabled,
all other buttons on the control box are active, and the daughter board will output the last used signal
immediately. Then you can selelct button 1 ~ 5 for different motor speed. Please note that all the duty cycle
ouput from daughter board is low level active.
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Figure 33 Output duty signals versus buttons
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3 System design

This section provides the complete details of the schematics, layout and connectors. Please note that the
schematics, routing and Gerber files are done in Altium® Designer. Users who are interested in the original
project files or pdf files can visit the website www.infineon.com and log-in to myInfineon and download on the
board’s web page.

3.1 Schematics

The major function blocks are introduced in Section 2.2 and Section 2.3 . Users who are interested in further
details can download the design files after logging in to the mylInfineon account on the board’s web page.

3.2 Layout

3.2.1 Main board layout

The main board is designed in a single layer and has a ring shape, with dimensions of 90 mm (D) x 65 mm (H).
The main board is manufactured with a copper thickness of 1 oz. (35 um).
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Figure 34 Top assembly print of the main board
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Figure 35 Bottom assembly print of the main board
Figure 36 Top layer of the main board
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Figure 37 Bottom layer of the main board

3.2.2 Daughter board layout

The daughter board is designed in double layers and has a square shape, with dimensions of 19 mm (L) x 15
mm (W)x 16 mm (H). The daughter board is manufactured with a copper thickness of 1 oz. (35 um).

Figure 38 Top assembly print of the daughter board

V1.0
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Figure 39 Bottom assembly print of the daughter board

Figure 40 Top layer of the daughter board

Figure 41 Bottom layer of the daughter board
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3.3

Bill of material

The complete bill of material is available on the download section of the Infineon homepage. A log-in is
required to download this material.

Table 4 BOM of the most important/critical parts of main board
S. No. Ref Designator | Description Manufacturer Manufacturer P/N
CAP/ELCO/22 uF/450
V/20%/Aluminiumelectrolytic/-
1 Cle 25°C t0 105°C/5.00 mm C X 0.60 | Wurth Elektronik | 860241478004
mm W 13.00 mm Dia X 26.50
mm H
CAP/FILM/100 nF/10%/MKP
(Metallized Polypropylene)/-
2 CX1 40°Ct0105°C/10.00 mm CX Wurth Elektronik | 890324023023
0.60 mm W 13.00 mm L X 7.00
mmTX13.50mmH
CAP/FILM/330 nF/275
V/10%/MKP (Metallized
Polypropylene)/-40°C to .
3 CX2 105°C/12.50 mm C X 0.60 mm Wurth Elektronik | 890324024003
W 15.00mmLX850mmTX
1450 mmH
CAP/CERA /4.7 nF/2.6
kV/20%/Y5U (EIA)/-40°C to
4 CY1,CY2 125°C/10.00 mm C X 0.55 mm Kemet C961U472MZWDBAT317
W13.00mmLX5.00mmTX
17.00 mmH
CAP/CERA/3.3 nF/2.6
kV/20%/Y5U (EIA)/-40°C to
5 CY3,CY4 125°C/10.00 mm C X 0.55 mm Kemet C941U332MZWDBAT317
W11.00mmLX5.00 mmTX
15.00 mmH
D1, D3, D4, i ON
6 D14 General purpose rectifier Semiconductor S1M
7 D2 1A E?OV— 1000'\/‘glass Tawan 1N4007G-K
passivated rectifier Semiconductor
High speed 5 IGBT in
TRENCHSTOP 5 technology Infineon
1 . . IKAOBN65H
8 Q copacked with RAPID1 fastand | Technologies 08NESHS
soft antiparallel diode
Q2, Q3, Q4, Q5, | Cost effective monolithically Infineon
. . . . IKNO3N60RC2
9 Q6, Q7 integrated IGBT with diode Technologies 03 ¢
Vo o~ TRENCHSTOP RC-Series for .
10 82,’ 82,’ 83,’, hard switching applications, !I'ntjlcr;izrl]o e IKDO4N60RC2
) N0 VCE 600V, IC 4A &
11 U1 Motor contr(?ller with Infineon . IMD112T-6E040
integrated high-voltage gate Technologies
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S. No.

Ref Designator

Description

Manufacturer

Manufacturer P/N

driver, Integrated script engine
for application control
customization, thin-film-SOI-
technology with negative
transient robustness, built-in
temperature sensor

12

Single low-side driver IC,
application general purpose
U2 gate driver, DC-DC converters,
plasma display panel
(PDP)applications

Infineon
Technologies

IRS44273LTRPBF

13

u3

Lowest component count,
energy-efficient off-line
switcher IC, 175 mA MDCM in
230 Vims

Power
Integrations

LNK305DG

*Q2',Q3',Q4',Q5',Q6', Q7" are alternatives of Q2, Q3, Q4, Q5, Q6, Q7, and Q2, Q3, Q4, Q5, Q6, Q7 are mounted by default.

Table 5 BOM of the most important/critical parts of daughter board
S. No. Ref Designator Description Manufacturer Manufacturer P/N
Remote receiver
1 U1 sensor, 40.0 kHz 14m Everlight IRM-3640T
Through Hole
XMC1000 industrial
microcontrollers ARM® | Infineon
2 2 . . XMC1100-Q024F0064
v Cortex®-M0 32-bit Technologies €1100-Q024F006
processor core
3.4 Connector details
3.4.1 Main board connectors
Table 6 X1, X2, X3 AC input connectors
PIN Label Function
X1 L AC line input
X2 N AC neutral input
X3 EARTH Earth connector
Table 7 J1- iMOTION™ link connector
PIN Label Function
5 GND Ground
6 +5V On board 5V supply
7 RXDO MCEDesigner & firmware download
8 TXDO MCEDesigner & firmware download
Table 8 J2 - Daughter board connector
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PIN Label Function
1 IR Duty Duty signal from daughter board
2 GND Ground
3 +5V On board 5V supply
4 Reserved Reserved
3.4.2 Daughter board connectors
Table 9 J1 - Main board connector
PIN Label Function
1 IR Duty Duty signal to main board
2 GND Ground
3 +5V On board 5V supply
4 Reserved Reserved
Table 10 J2 - XMC1100 programming connector
PIN Label Function
1 +5V On board 5V supply
2 SWCLK SWCLK pin of serial wire debug (SWD)
3 SWD SWD pin of serial wire debug (SWD)
4 GND Ground
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4.1 PFC iTHD at rated condition

PFC performance is tested at a rated input voltage of 230 Vrms and output rated power of ceiling fan motor.

Table 11 PFCiTHD at rated condition
Input voltage Input current (A) | PFCDC target (V) | Input power(W) | Power factor |iTHD(%)
(Vrms)
230 0.137 360 33.2~34.0 0.968~0.974 9.33~9.74
Legend CH1: lac, CH2: Vac, CH3: Vdc, CH4: IL
Condition ® Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor
speed: 360 rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30
Tel _Slnp ) Tek Roll
A IEC 61000—3—2 Harmonics, Class A
THD-F 9.44 % ;
T i I T RMS 137mA R
.- . P R . . I I P PR Overall Pass _
POHC 5.15mA
: . b POHL 251mA
Freq Mag Mag Limit Pass Max all 200% POHC
RMS Fail Windows Limit Limit
B NN SN e B w ® [y
L14 - T H A1 50.02 99.7 136m — nsa 136m n/a n/a ii
[3ivde V Nt T/ W al? 100.0 422m 5744 1.08 Pass  583u Pass nsa HETLI
= 713 150.1 6.49 8.82m 2.30 Pass 8.85m Pass ns/a
4 2001  276m 3754  430m  Pass  380p pass n/a
5 250.1 3.73 5.08m  1.14 pass  5.10m pass n/a
6 300.1 275m 374 300m Pass 394 Pass n/a
7 3501 1.05 1.42m 770m  Pass  1.43m Pass n/a j
8  400.1  220m 312  230m  Pass 326 pass nsa
9 4502 542 737 400 p 753 p /
= gg%mj : z J{W.Oms }&‘mfﬁs ?OOIA J T —n 305ﬁ ES TR 314ﬂ e ‘Wm
Value Mean Min Max Std Dev ! — Acquisition Window too small 16:16:25 j
@ RviS 137.1mA  40.05m 23.63m 141.0m 38.58m 30 Jun 2021| o - ) Test to Save
11 pplication Analysis Define IEC 3
‘RMS 363.2v  362.7 361.5 363.2 346.2m VA Powser H""m"“i“‘ Inputs Stﬂ&dcard J setup J PP J t“geFaislé J
Tek Stop —~ Tek Prevu M 10.0ms
ERiLc o™ TSl | Sl Sl =
Z00m Factor: TkX Zoom Position: 3.87ms —~
0 3.850ms @ 184.0mA
(@] 3.852ms () 240.0mA
vac .am‘ Jm‘_ . i N PN ot N A1.700ps  AS56.00mA
ST G W S R i i B (Y N dud__szaakas
(] el
Rl
B
@ sS00mA & 2 ][lﬂ.ﬂms 10.0MS/s @B S ] @ 500mA & 2 }[Zlﬂ.ﬂps 10.0MS/s @ & }
@ 200mA & 1M points 4.00 A @ 200mA & 1M points 4.00 A
value Mean Min Max Std Dev H Value Mean Min Max Std Dev
@ RMS 136.7mA  136.7m 136.7m 136.7m 0.000 30 Jun 2021| |@RMS 197.7mA  197.7m 197.7m 197.7m 0.000 fg J]L:;I‘IHZUZI
2 16:17:19 2 118:
@ RMS 363.0V  363.0 363.0 363.0 0.000 @ RMS 363.4V  363.4 363.4 363.9 0.000
Figure 42 PFCiTHD at rated condition

4.2 Bus voltage ripple

The bus voltage ripple test of input voltage is from 120 Vrms to 270 Vrms. The maximum bus voltage is 395 V.

Table 12 Bus voltage ripple
Input voltage (Vrms) PFC DC target (V) Ripple voltage (V) (%)
120 302 8 2.6
150 305 8 2.6
230 360 7 1.92
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270 395 75 | 1.89
Legend CH1: lac, CH2: Vac, CH3: Vdc
Condition ® Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only
mode, motor speed: 360 rpm.
TekStop - Tek Stop
F - - . . 5 . - — —— i — - - - - - =
H 7.70ms @ 3120V : oo O  ssooms @ 297.0V
e : ~19.00ms @ 296.0V [b] : O -10.90ms () 313.0V
o A1.300ms A16.00V S : o A16.40ms A16.00V
i dv/dt 12.31kv/s e o : : dv/dt —975.6 V/s
Blvdc /-\ e /—\ /\ /\ Bvdc i P
'. 500‘mA 8 ‘ ‘2 J[w.oﬁus 10.0MS/s @ S ] T @ s00mA & 2 }[16.0m5 10.0MS/s @B 7 ]
& 500V o 1M points  4.00 A @ 500V & 1M points __ 4.00 A
Value Mean Min Max Std Dev Value Mean Min Max 5td Dev - -
& RMS 267.3mA  270.8m 260.9m 279.3m 4.932m 30 Jun 2021| | @B RMS 210.0mA  210.0m 210.0m 210.0m 0.000 30 Jun 2021
2 15:01:38 2 15:24:46
& RMS 302.3V_ 304.2 301.9 305.7 1.240 @ RMS 305.3V_ 205.3 305.3 305.3 0.000
Tek Stop Tek Stop
H b [ H 4 B H 4
: ' : A O 100.0us & 3700V [ ] -32.80ms @ 405.0V
i - - S T C -5.200ms () 3560V £ O -20.30ms () 3900V
D N = B AS5.300ms A14.00 V T A3.500ms A15.00 V
: o - dv/dt 2.642kV/s Lo dvrdt —4.286kV/s
i ‘Iac: o Jm\ ‘ A J”.‘\_‘ Jm A Tivac J:IA /‘\ /W\ ,‘\ A
i St St : o/ M| T S N ™~
Evdc A .
i . L \- 1 @lvac/
[ ) SOOImA & 2 . }[10.0m.s 10.0M5/s .' r ] [ ) Sll)ﬂr‘nA 5 2 J[w.ﬂms 10.0MS7s @ 7 J :
@ 500V & 1M points 4.00 A @ soov & 1M points  4.01 A
value Mean Min Max Std Dev value Mean Min Max Std Dev i
@ RvS 136.8mA  136.8m 136.8m 136.8m 0.000 30 Jun 2021| | @ RMS 122.8mA  122.8m 122.8m 122.8m 0.000 30 Jun 2021
2 16:11:40 2 16:56:36
& RVS 363.0V  363.0 363.0 363.0 0.000 & RMS 397.6V  397.6 397.6 397.6 0.000
Figure 43 Bus voltage ripple at input voltage: 120 Vrms, 150 Vrms, 230 Vrms, 270 Vrms

4.3 PFC IGBT Vce dv/dt performance

Table 13 PFC IGBT Vce dv/dt performance
Input voltage | Input power Input current | PFC DC target Power
fVce (V
(V) (W) (A) (V) factor dv/dt of Vce (V/ns)
120 34.2 0.283 260 1 4,280~ 3.344
230 33.9 0.154 360 0.974 4.306 ~ 2.897
Legend CH2: Vce, CH3: Vge, CH4: Ic
Condition ® Typical PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor
speed: 360 rpm.
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Tek Prevu M 4.00ms
i e M e e
[33vge

Zoom Factor: 4kx Zoom Position: 731

[34vqe 5 g
2 Z 1.00us 125MS/s o - ;
@ 100V @ so00mA 5M points 1.85V 26 Aug 2021
value Mean Min Max Std Dev 10:52:07
RMS 330.6mA  330.6m 330.6m 330.6m 0.000
Tek Prevu M 4.00ms Tek Prevu M 4.00ms
Flavce Flavce
[3:{vge [33{vge
Zoom Factor: 4_0kx Zoom Position: 728\ . . Zoom Factor: 4_0kx
B0 : : :
(2} : (2}
[b] : [b]
Fhvce B FHvce
[3j¥ge—————— e [3YVae S
2 Z 100ns 125MS/s @B 1 ; 2 Z 100ns 125MS/s @B 1
@ 100V @ 500mA SMpoints  1.85V  Jl26 Aug 2021] (@B 100V @ soomA 5M points  1.85V _ J/26 Aug 2021
Value Mean Min Max Std Dev 10:54:51 Value Mean Min Max Std Dev 10:55:55
@ RMS 331.3mA_ 331.3m 331.3m 331.3m 0.000 @ RMS 278.3mA_ 278.3m 278.3m 278.3m 0.000

Figure 44 PFC IGBT Vce dv/dt performance at input voltage =120V

Tek Prevu M 4.00ms
Ed{lce
[3:{vge

Zoom Factor: 10kX Zoom Position: 12.1Js

3 :quwﬂ

2 Z 400ns 125M5/s @ S
@& 100V @ 200maA 5M points 1.85V 25 Aug 2021
value Mean Min Max Std Dev 15:51:52
@ rMS 166.4mA  166.4m 166.4m 166.4m 0.000
Tek Prevu M 4.00ms Tek Prevu M 4.00ms
Fvce . . . PHvce |
135{vge [3:{Vgel
Zoom Factor: 40kX Zoom Position: 11.7ps _ _ Zoom Factor: 4_0kX Zoom Position: 13.6M S_
e 0 : 3
: =) 2]
b} (b}
Phvee : : : : 1 Plvee .
2 Z 100ns 125M5/s @ £ 2 Z 100ns 125MS/s @ 1
@ 100V @ 200mA 5M points  1.85 V 25 Aug 2021 @ 100V @ 200mA 5M points  1.85V 25 Aug 2021
value Viean Min Max Std Dev 16:49:35 value Mean Min Max std Dev 15:53:26
@ rMS 206.4mA  206.4m 206.4m 206.4m 0.000 @ rMS 155.2mA_ 155.2m 155.2m 155.2m 0.000

Figure 45 PFC IGBT Vce dv/dt performance at input voltage =230V
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4.4 PFC thermal performance
Table 14 PFC thermal performance
Input H
Input Input PFCDC Power Component with o
power AT(C)
voltage (V) (W) current (A) target (V) | factor max temperature
120 34.2 0.283 300 1 PFCIGBT 61.2
150 33.9 0.146 300 0.947 PFCIGBT 52.8
230 34.4 0.146 360 0.978 Motor IGBT 61.5
270 35.7 0.136 394 0.965 Motor IGBT 71.2
Condition ® PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 360
rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30.
120.0C
20.0C
74 Analysis I%ﬂ Position] % Obj. Parl (i ] Imagel Text comment
Label Value [°C] Min Max| Max - Min Avg Stdev
Image 28.6 89.8 61.2
ARO1 43.0 89.7 46.7 78.6 14.0
ARO2 49.0 704 214 65.4 4.8
ARO3 754 80.0 4.7 79.2 0.6
ARO4 50.4 65.5 15.1 61.9 3.0
Figure 46 Input voltage =120V
120.0C
20.0C
74 Analysis I%ﬂ Position | %, Obj. Par | € Image | [ Text comment
Label | Value [°C] | Min Max| Max - Min | Avg Stdev |
Image 288 816 52.8
ARO1 41.0 816 40.6 68.1 13.2
AR02 54.9 721 17.2 69.3 27
ARO3 56.2 69.3 131 68.5 11
ARO4 57.1 70.2 13.2 66.2 41
Figure 47 Input voltage =150V
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120.0C

20.0C

74 Analysis I@ Position | %, Obj. Par | €) Image | E¥ Text comment

Label Value [°C] Min Max| Max - Min Avg Stdev F
Image 283 89.8 61.5

AROL 374 734 36.0 61.5 125
ARO2 63.8 89.8 26.0 85.1 6.1
ARO3 48.8 56.5 7.7 55.9 0.6
ARO4 68.5 735 51 719 12

Figure 48 Input voltage =230V

120.0C

100

80

60

40

20.0C

§¢ Analysis l%ﬂ Position] % Obj. Parl (i) Imagel Text comment

Label Value [°C] Min Max| Max - Min Avg Stdev R
Image 28.2 99.4 71.2

ARO1 35.8 70.8 35.1 59.8 116
ARO2 68.0 99.4 314 94.0 7.5
ARO3 47.6 56.2 8.6 53.4 0.5
AR0O4 68.4 74.2 5.8 724 15

Figure 49 Input voltage =270V

4.5 Inverter IGBT dv/dt performance

IKNO3N6ORC2 is used here for the inverter IGBT dv/dt performance test.

Table 15 Inverter IGBT dv/dt performance
.t Input Input power PFC DC target
P f
Current position voltage (V) | (W) V) ower factor | dv/dt (V/ns)
At positive current | 230 34.5 360 0.976 0.576~1.38
Near zero current 230 34.5 360 0.976 0.514~1.518
At negative current | 230 34.5 360 0.976 0.36 ~1.325
Legend CH1: Vge for low side, CH4: Vge for high side ,CH3: phase output current, CH2: Vce for low side
Condition ® PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed: 360

rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30.
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Figure 52 At negative current
4.6 Inverter IGBT dead time test
IKNO3N60ORC2 is used here for the inverter IGBT dead time test.
Table 16 Inverter IGBT dead time
Input voltage | Input power | PFCDC Power . .
Tdon+Tr (ns) | Tdoff+Tf (ns) | Min dead time (ns
(V) (W) target (V) | factor (ns) (ns) (ns)
120 35.8 260 1 84 512 428
Legend CH1: Vge for Low side, CH2: Vce for low side, CH3: phase output current.
Condition ® PWM setup for: 60 kHz PFC and 16 kHz motor PWM, 3-phase only mode, motor speed:
360 rpm.
® PFC control parameters: Kpl=400, KxI=600, KpV= 1500, KxV=30.
Tel k Prevu : | M 4.00ms
Bl
E” Lol w111 | - Vel ‘ NHHH | \
Zoom Fac:tor: 20kX Zoom POSIII:OH: —10.7ms Zo0m Factor 10kX : Zoom P:OSItIOH —10.7ms
: . . :—10.68ms 1.000Vv : : i i O -10.68ms € 1:2.3[1V
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Figure 53 Inverter IGBT dead time
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4.7 Electromagnetic interference (EMI) conducted

This section shows the conducted EMI of REF-SHA35WRC2SYS. Test limits follow the EN 55032: conducted
disturbance at the mains ports of class B ITE (information technology equipment).

Table 17 Limits for conducted disturbance at the mains ports of class B ITE
Frequency range (MHz) Limits (dB(uv))
Quasi-peak Average
0.15t00.5 66 to 56 56 to 46
0.5t05 56 46
5to 30 60 50
Note: 1. The lower limit applies at the transition frequencies

2. The limit decreases linearly with the logarithm of the frequency in the range 0.15 MHz to 0.50

MHz
Table 18 EMI test result
Operation Phenomenon
Standby mode Pass
Motor and PFC run Nearly pass

Condition ® Motor runs at 360 RPM without load
® | =10mH,CM =22 mH, X=100 nF(CX1) + 330 nF(CX2), Two stageY=3.3 nF(CY3, CY4)+4.7
nF(CY1, CY2), PFC Rg =330 Ohm, motor Rg =620 Ohm

80.0

70.0

60.0
|

50.0
|

40.0

Bl IR TR T Y

10.0

0.0

150 kHz 1 MHz 10 MHz 30 MHz

Figure 54 Standby mode
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80.0

70.0

20.0

10.0

0.0

150 kHz 1 MHz 10 MHz 30 MHz

Figure 55 Motor and PFC run

Note: The short and strong PE connecting line is very important for reducing conducted disturbance at
the mains ports of class B ITE
4.8 Surge immunity test
This test is compliant with IEC standards: IEC61000-4-5; the specificationis L to N 4 kV.

Add surge pulse from 0.5 kV to 4 kV on L-N. PFC runs normally, and motor runs at 360 RPM without load.

Table 19 Surge pulse condition
Pulse voltage [Basic voltage |[Connection hNaveform Coupling IASYNC/ SYNC [Interval times
impedance  Angle Total times
0.5~4kV 230Vrms  |L-N 1.2/50 us |18 uF ASYNC 60s / 5 times
SYNC-0° 60s / 5 times
SYNC-90° 60s / 5 times

SYNC-180° 60s / 5 times
SYNC-270° 60s / 5 times
0.5~4KkV 230Vrms L-PE/N-PE [1.2/50 us P uF+10ohm ASYNC 60s / 5 times
SYNC-0° 60s / 5 times
SYNC-90° 60s / 5 times
SYNC-180° 60s / 5 times
SYNC-270° 60s / 5 times

1~2 kV motor & PFC work fine, with only slighy disturbance; 2~4 kV surge trigger overvoltage fault; system can
go back to work after clearing the fault or re-powering on.
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4.9 System test with infrared control

This test connects the main board and daughter board with cables provided, and uses the script code in
Section 2.1.3 Code Listing 1 for remote infrared control as shown in Figure 6. The test result is shown in Table
20.

Table 20 System test result
Gear |[Input Motor PFCDCtarget |iTHD(%) |Input Power factor | Input
voltage |speed (V) power current
(Vrms) (rpm) (W) (mA)

1 39 168 56.5% 1.8 0.811 21.7

2 119 168 24.3% 3.5 0.924 33.1

3 120 199 196 9.12% 8.7 0.961 7.4

4 279 275 5.18% 19.7 0.989 164.7

5 360 350 6.37% 36.5 0.998 298

1 39 211 70.8% 2.1 0.731 25.54

2 119 211 34.6% 3.8 0.897 32.55

3 150 199 209 17.40% 8.5 0.943 63.67

4 279 275 5.63% 19 0.981 128.2

5 360 354 4.02% 34.8 0.996 260

1 39 281 76.8% 3 0.662 25.46

2 119 281 59.1% 4.8 0.817 31.32

3 200 199 281 24.00% 9.6 0.938 52.43

4 279 279 11.30% 18.9 0.957 100.3

5 360 354 4.93% 34.3 0.987 174.1

1 39 354 75.9% 4.1 0.643 28.59

2 119 352 70.4% 5.9 0.748 33.86

3 250 199 350 35.00% 10.8 0.913 48.31

4 279 349 17.40% 19.4 0.956 83.2

5 360 354 8.06% 33.1 0.968 137.7

1 39 PFC stopped, 139.0% 5.3 0.409 455
Bus=419

2 119 PFC stopped, 151.0% 6.9 0.436 54.91
Bus=417

3 300 199 PFC_stopped, 162.0% |11.8 0.479 84.5
Bus=416

4 279 PFC stopped, 159.0% 21 0.511 134
Bus=413

5 360 PFC stopped, 154.0% 34.4 0.528 241.7
Bus=408
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5 References and appendices

5.1 Abbreviations and definitions
Table 21 Abbreviations

Abbreviation Meaning

CE Conformité Européenne

EMI Electromagnetic interference

uL Underwriters Laboratories

RC-D2 Reverse-conducting drive 2

5.2 References

[1] Infineon Technologies AG. Datasheet of IKNO3N60RC2 (2021) V1.0 www.infineon.com

[2] Infineon Technologies AG. Datasheet of IMD112T-6F040 (2020) V1.0 www.infineon.com

[3] Infineon Technologies AG. Datasheet of IRS44273L (2021) V1.0 www.infineon.com

[4] Infineon Technologies AG. MCEWizard_V2.3 User Guide (2019) www.infineon.com

[5] Infineon Technologies AG. MCEDesigner_V2.3 Application Guide (2019) www.infineon.com

[6] Infineon Technologies AG. iIMOTION™ Motion Control Engine Software Reference Manual (2021) V1.34

www.infineon.com

5.3 Additional information

In order to initiate testing, customers are advised to order the iMOTION™ link; detailed information is listed in

Table 22.

The Infineon components on the board are listed in Table 22 as well. The customers can visit the corresponding
webpage for more information.

Table 22 Additional information on tools and Infineon components

Base part number Package Standard pack Orderable part number
Form Quantity

iMOTION™ link Container 1 IMOTIONLINK
IMD112T-6F040 PG-LQFP-40 Tape and reel | 1500 IMD112T6F040XUMAL
IKDO4N60RC2 PG-T0O252-3 Tape and reel | 2500 IKDO4N60RC2ATMAL
IKNO3NG60ORC2 PG-S0T223-3 Tape and reel | 2500 IKNO3N60RC2ATMAL
IRS44273L PG-SOT23-5 Tape and reel | 3000 IRS44273LTRPBF
IKAOBN65H5 PG-T0220-3 Tube 500 IKAOBN65H5XKSAL
XMC1100-Q024F0064 AB | PG-VQFN-24 Tape and reel | 6000 XMC1100Q024F0064ABXUMAL
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